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1 Introduction

GoldWave™  is  a  Microsoft  Windows™  3.1  application  that  uses  the
standard  audio  interface  to  create  a  full  digital  editing  and  effects  studio.
GoldWave includes several features not found in current audio applications, such
as  an  expression  evaluator,  an  oscilloscope,  a  device  controls  window,  and
independent left/right channel editing of stereo sound files.

The expression evaluator allows you to generate everything from simple sine
waves to band-pass filters.  It supports over 20 common functions and operations.

The oscilloscope displays sounds as they are being played or recorded.  You
can see what the sound looks like.

The  device  controls  window  contains  buttons  for  playback,  recording,
volume, etc.  The window is separate from GoldWave's main window and allows
more flexible control of audio devices.

Along with the standard editing functions of cut, copy and paste, GoldWave
has several audio effects built in.  These include reverse, echo, fade out, volume,
and silence.  GoldWave employs a multiple document interface (MDI) so that up to
5 sounds can be loaded at one time, making file-to-file editing easy.  The sounds
are displayed graphically and you can zoom in to see higher detail.  In fact, you
can zoom in far enough so that a single sample is graphed.

This manual presents and explains many features of GoldWave.  The first
part discusses system requirements, installation, etc.  The second part covers the
menu structure.  Topics are covered in the order that they appear in the main menu.
The  final  section  provides  general  information  (shareware  concept,  warranty,
registering, etc.).  Please be sure the read the shareware/warranty section!  For
users who are unfamiliar with digital audio, Appendix A briefly introduces some of
the fundamentals of digital sound.  It  also provides some solutions to common
recording problems.  This manual assumes that users are familiar with Microsoft
Windows™.

2 Getting Started

2.1 System Requirements



The minimum system requirements for GoldWave are:

16MHz 286 IBM PC or compatible
Microsoft Windows™ 3.1
4 Megabytes of RAM
1 Megabyte free on your hard disk
A mouse
An EGA/VGA card and monitor
An MPC audio card and software driver (or PC speaker driver)

A math processor is not required, but it is recommended if you will be using the
expression evaluator often.

2.2 Notation Used in this Manual

Bold text and a vertical bar '|'  are used to indicate menu commands.  For
example, File | New means to select the New command from the application's File
menu.

2.3 Installation

GoldWave and all its files should be kept in a single directory of its own (the
file list is given in the General Information section).  The best way to do this is to
unzip GOLDWAVE.ZIP into a new directory.
For example, in DOS:

1) C:>mkdir gw
2) C:>copy goldwave.zip gw
3) C:>cd gw
4) C:>pkunzip goldwave.zip

Before running GoldWave make sure that you have installed an appropriate
Windows sound driver using the Control Panel "Drivers" Applet.  The driver and
installation instructions should be included with the hardware.  If you do not have a
sound card, then you can use the PC-Speaker driver (you may have to search BBS
or ftp sites to find this, since it is not included with Windows).  Note: Since the PC-
Speaker driver does not return control to Windows until after the sound has finish
playing, the oscilloscope and stop & pause buttons will not work.

To add a GoldWave icon to a Program Group use File | New on the Program



Manager's menu, select Program Item then click OK.  Type "GoldWave v1.00" as
the description.   Select  Browse,  find and double click on "goldwave.exe",  then
click OK.

To run GoldWave, either double click on the GoldWave icon or use  File |
Run on the Program Manager's menu.

GoldWave allows you to choose which devices to use for input and output.
Selecting  Options |  Output device presents  you with a list  of  installed output
devices and shows their capabilities.  Choose the device you wish to use.  A similar
list is presented for Options | Input device.

Be sure to check the readme.txt file for any additional information.

3 Using GoldWave

3.1 Window Overview

GoldWave is composed of three types of windows: the main window, the
Scope and Controls window, and sound windows.  The main window contains the
menu and a row of buttons.  It groups together and manages all the sound windows
when they are opened.  At the bottom of the main window is an information bar
that gives you attributes of the active sound window.

The Scope and Controls window provides an easy to use interface to your
audio hardware.  It  contains buttons to play,  record, and stop sound as well as
controls  for  volume,  balance,  and playback speed (provided your  audio  device
supports these features).  An oscilloscope is displayed here whenever a sound is
played or recorded.  See Scope and Controls Overview in a following section.

Sound windows are created when you open a file.  Up to 5 sounds can be
opened at any one time.  These windows contain a graph of the sound with a time
axis near the bottom.  For stereo sounds, two separate graphs are shown with the
top  (green)  graph  as  the  left  channel  and  the  bottom (red)  graph  as  the  right
channel.  At the bottom of the sound window is a small "Overview" box.  This box
shows you what part of the sound is selected (highlighted green and/or red), what
part is displayed in the above graph (black background), what part is not visible in
the above graph (dark grey background).  Initially, the entire sound is visible and
selected.

GoldWave makes extensive use of "bitmapped buttons".  These buttons have
pictures which help describe their purpose.  Buttons containing no colour (only
shades of grey) are disabled.  They are disabled when the function they perform is
invalid.   Most  buttons  are  disabled  when  you  initially  run  GoldWave.   After
opening a sound file, most of these buttons will become enabled.

Note Version 1.00: the rewind and fast forward button serve no purpose and



are never enabled.  The commands Borg, Helium, Time comp/exp, Print, Pitch,
were not ready for this version (maybe the next version will have them, if I have
time).

3.2 Editing Overview

The GoldWave editor is block based.  A block is defined as the highlighted
part of the sound graph between two vertical markers.  All editing and effects are
performed on this highlighted block.  As mentioned in the previous section, when a
sound file is first opened, the block is the entire sound.  The vertical markers are
cyan  lines  located  at  the  far  left  side  (start  marker)  and  far  right  side  (finish
marker) of the graph.  They may be difficult to see.

There are two ways to move the markers, depending on Options | Settings
setup.   GoldWave  does  not  use  Windows'  standard  "click-and-drag"  method
because it does not allow accurate positioning of the markers.  The methods below
allow you to independently set the start and finish markers to an individual sample
(when zoomed in at a 1:1 level or better).

Method 1:
The default method (check "Quick block select" in  Options | Settings), uses the
left  and  right  mouse  buttons  to  set  the  start  and  finish  markers  respectively.
Whenever the mouse arrow is inside the sound graph, the arrow changes into a
vertical bar with small arrows on either side.  This means that you can change a
markers position.

To move the start marker:
Click the left mouse button on the graph at the point where you want to
place the start marker.

To move the finish marker:
Click the right mouse button on the graph at the point where you want to
place the finish marker.

Note that you cannot place the finisher marker before the start marker.  The same is
true for setting the start marker after the finish marker.

The drawback of  this  method is  that  it  is  easy  to  accidently change the
start/finish marker when clicking on a sound window.

Method 2:



If the "Quick block select" check box in  Options | Settings is not checked, then
selection method 2 is used.

To move a marker, position the mouse arrow over it.  You should see the
arrow change into a vertical bar with small arrows on either side.  You can then
click and drag the marker to a new location.  For example, to move the start marker
from its original position:

1) Move the mouse arrow to the far left side of the graph.  Make
sure it is inside the graph area and the arrow shape has changed.
2) Press and hold the left mouse button.
3) Move the mouse to the right.
4) Release the mouse button when the start marker is at the desired
position.

Note Version 1.00:  You must have a mouse to move the start/finish markers since
there are no keystrokes which will move them.

To find a certain part of the sound, you can play the sound and mark it as it
plays.  GoldWave indicates the part being played with a white vertical line.

In most cases, editing and effects are performed only on the active sound
window, which is the one that is on top.

Window's clipboard (a temporary storage area that all applications can use)
is used for most of the editing commands.  Note that cutting or copying a large
block into the clipboard can consume a lot of memory.

See  Editing  under  the  Options  section  for  information  about  controlling
independent channel editing.

3.3 Scope and Controls Overview

The Scope and Controls window is an easy to use interface to your audio
hardware and/or drivers.  In the upper half of this window is the oscilloscope box
in  which  sound  is  graphed  "real-time"  during playback  and  recording.   In  the
middle of the window is a standard set of tape recorder controls.  From left to right
the buttons are: rewind, pause, fast forward, play, stop, and record (in version 1.00
the rewind and fast forward buttons serve no purpose).  In the lower half of the
window are controls to set the devices output volume, balance, and playback speed
(not many devices support speed control).

3.3.1 Playing sounds
After opening a sound, you can use the play button (the one with a green

triangle that points to the right).  While a sound is playing, it is shown graphically



in the oscilloscope box.  The current position is shown in the graph of the sound
window with  a  vertical  white  line.   Sounds  can  be  played  only  if  the  driver
supports the sound's format and attributes.  By using Edit | Copy and Edit | Paste,
it is possible to convert a sound to a playable format.

3.3.2 Pausing playback
While  a  sound  is  playing,  you  can  pause  it  with  the  Pause  button  (two

vertical blue bars).  Remember to use either play or stop later.  Pause will freeze
the oscilloscope so you can see the shape of the sound.

3.3.3 Stopping sounds
Recording and playback can be stopped immediately with the stop button

(red square).

3.3.4 Recording sounds
The record button (red circle with letter 'R' in it) allows you to record your

own  sounds.  Recording  occurs  inside  the  block.   The  block's  data  will  be
overwritten.  To make room for recording without overwriting the block, you can
use Edit | Insert space.  Recording will automatically stop when the block is full.
You can stop recording at any time with the stop button.

Recording  is  successful  only  if  the  driver  supports  the  active  sound's
attributes/format.  You can try recording into a new sound (File | New) and use
Edit | Copy and Edit | Paste to overcome this limitation.

3.4 File Menu Commands

3.4.1 New
Creates a new sound file with attributes you specify.  These attributes are

discussed  in  Appendix  A.   Note  that  GoldWave allows you to  create  and edit
sounds that  may not  be playable  with your  audio hardware.   Check  Options |
Output device for attributes compatible with your hardware.

3.4.2 Open (Open Button) and Supported File Formats
Presents you with a list  of  files.   By default,  all  files with the extension

".wav" are  listed.   You can change the  extension to  search  for  different  sound
formats.  After you select a file, it is opened and given its own sound window.  Its
attributes are displayed in the information bar.

Sound files are similar to document files in that different word processors



save files in different formats.  For example, Window's Write uses a special format
with a ".wri" filename extension, but Notepad uses a plain format with a ".txt"
extension. 

GoldWave supports all the sound formats listed in the table.
Extension Comments
.au

Sun or NeXT format.  Supports 8&16-bit linear and uLAW
encoded files.  Encoded files are converted to 8 bits or 16
bits, depending on Options | Settings selections (8 bits by
default).  The conversion process can take a minute or so
for long sound files.  The header block is preserved.

.iff
Amiga 8SVX format.  The blocks NAME, COPY, ANNO,
AUTH, and CHAN are all preserved.

.snd
Raw  or  NeXT  format.   NeXT  format  is  automatically
detected.   Raw  format  presents  a  dialog  to  specify  the
format.

.wav
RIFF WAVE 8-bit and 16-bit PCM mono or stereo.  Only
files with one data chunk are supported.  Only the INFO
chunk is preserved.

.voc
Sound Blaster files.  Only 8-bit unpacked mono files are
supported.

GoldWave  will  present  an  attribute  dialog  if  the  file  is  corrupted,
unrecognized, or contains data without header information (raw files).  This dialog
allows you to select one of three general sound formats and give specific attributes.
If you don't know the file's format or attributes, experiment with trial-and-error.
Generally,  sounds will  be noisy if  the format or number of bits is incorrect,  in
which case you will have to close and re-open the sound using a different format.

If the sampling rate is wrong, the playback speed will be too fast or too slow.
You can use  Effects | Playback rate to quickly re-adjust this.  Appendix A has
more information about sound attributes.



3.4.3 Save
Saves the active sound file to the disk.  The sound is saved with the same

name and format that it was opened.  If memory or disk space is low, the file may
not be saved successfully.  GoldWave will inform you if this happens.  If Save
fails, try deleting some unneeded files and close other applications.  Make sure that
the file is saved successfully before closing GoldWave, otherwise data may be lost.

3.4.4 Save as
Allows you to save a sound file under a different name.  You cannot save a

file in a different format.  You should provide an appropriate extension, since none
will be appended.

3.4.5 Exit
Closes  all  sound  windows  and  quits  GoldWave.   All  sound  playback  /

recording is stopped.  You will be asked to save any changes.

3.5 Edit Menu Commands

This section assumes that you are familiar with the terms introduced in the
"Editing Overview" section.

See Also: Editing in the Options section.

3.5.1 Cut (Cut Button)
Removes the block from the active sound and puts it in the clipboard. The

contents of the clipboard can then be pasted into a sound window using Paste.
To cut:

1) Move the start and finish markers to the part of the sound you
want to cut.
2) Choose Cut from the Edit menu or click on the Cut button.

3.5.2 Copy (Copy Button)
Copies the block into the clipboard.  The block is not removed.  The contents

of the clipboard can then be pasted into a sound window using Paste.
To copy:

1) Move the start and finish markers to the part of the sound you
want to copy.
2) Choose Copy from the Edit menu or click on the Copy button.



3.5.3 Paste (Paste Button)
Places  the  sound  in  the  clipboard  into  the  active  sound.   The  sound  is

inserted at the start marker's position.  The length of the active sound is increased
so  that  the  clipboard  sound  will  fit.   The  clipboard  sound  is  automatically
converted to match the attributes of the active sound.
To paste:

1) Move the start marker to the place where you want to paste the
clipboard sound.
2) Choose Paste from the Edit menu or click on the Paste button.

Tips: By copying a small block and pasting it several times, a stutter effect can be
achieved.
You can use Paste to convert stereo to mono by copying from a stereo file
and pasting to a mono file.
If a sound format is not supported by your audio device, use File | New to
make a new compatible sound.  Copy from the original, then  Paste to the
new.

Technical Note:  Clipboard data is automatically up-sampled or down-sampled to
keep pitch and playback speed constant.  You can use Effects | Playback rate to
change the playback speed before copying/cutting.

3.5.4 Mix (Mix Button)
This is a special editing feature for sounds.  The sound in the clipboard is

blended (superimposed) with the active sound.  You are asked for the mix volume.
This volume is applied to the clipboard sound as it is being mixed (see Volume in
the Effects section).
To mix:

1) Move the start marker to the place where you want to mix the
clipboard sound.
2) Choose Mix from the Edit menu or click on the Mix button.

3) Enter the volume to mix the clipboard (100 = normal volume).
4) Choose OK.

Tip: With this feature you could add your own vocals to music.

Technical Note:  Clipboard data is automatically up-sampled or down-sampled to
keep pitch and playback speed constant.  You can use Effects | Playback rate to
change the playback speed before copying/cutting.



3.5.5 Delete (Delete Button)
Delete removes the block from the active sound.  The block is not copied to

the clipboard.  Note that if only the left or right channel is active in a stereo sound,
then only that channel is removed.  Since it is not possible for one channel to be
larger than the other, the end of the deleted channel is padded with silence (this is
also true for Cut).
To delete:

1) Move the start and finish markers to the part of the sound you
want to delete.
2) Choose  Delete from  the  Edit  menu  or  click  on  the  Delete
button.

3.5.6 Insert space (Space Button)
Inserts some blank space in the active sound at the start marker's position.

You are asked how long (in seconds) the space should be.  This command can be
used to increase recording time.

3.5.7 Select view (Sel Vw Button)
Moves the start and finish markers to the far left and far right of the graph.

It selects the part of the sound shown in the graph.

Tip:  After editing or adding an effect, a quick way to play the entire sound is to
click on the Out button, then the Sel Vw button, then the Play button.

3.6 View Menu Commands

This section assumes that you are familiar with the terms introduced in the
"Editing Overview" section.

The following commands allow you to get more (or less) detail about the
actual shape of the sound.  They are similar to Paintbrush's zoom commands.  The
Overview box near the bottom of each sound window gives you useful information
about what section of the sound is currently in the graph.

When you have zoomed into (magnified) a part of the sound, a scroll bar
will appear at the bottom of the sound window so you can move to different parts
of the sound while still keeping the same level of magnification.

If you opened a long sound, the graph will not be accurate.  Generally, the
longer the length of time that is graphed, the less accurate the graph will be.

3.6.1 Zoom block (Block Button)



Increases detail  by graphing only the part  of  the sound in the block.   It
essentially magnifies the block.  By selecting a new block, you can zoom in even
further.
To zoom in on the block:

1) Move the start and finish markers to the part of the sound you
want to magnify.
2) Choose Zoom block from the View menu or click on the Block
button. 

3.6.2 Zoom 1:1 (1:1 Button)
Gives you an accurate, full-detail graph of the sound at the start marker's

position.  Technically speaking, one sample is mapped to one pixel on the screen.
This level of magnification is good for finding defects (pops and clicks) in sounds.

3.6.3 Unzoom (Out Button)
Shows the entire sound in the graph.  When sound files  are opened, the

graph is unzoomed.

3.7 Effects Menu Commands

This section assumes that you are familiar with the terms introduced in the
"Editing Overview" section.

With these commands, you can change a sound or create new sounds.  The
commands are  comparable  to  Font  Menu Commands in  word processors.   For
example, using font commands, you can change the size of text.  In GoldWave,
using the "Volume" effect changes the "size" (amplitude/volume) of a sound wave.
Note: Some of the effects may require a few minutes to complete.

See Also: Editing in the Options section

Technical Note:  Even though the word 'volume' is used throughout this section,
the amplitude is changed linearly (logs are too slow).

3.7.1 Echo
Produces an echo effect with the block.  The echo delay and volume (see

Volume) can be entered after choosing this command.  You may want to try the
default values first.

The longer the delay, the longer it takes for the echo to "bounce" back.  Try
values less than 0.1 for a large room, 0.3 for a baseball stadium, above 0.3 for a



canyon echo.
The lower the volume, the quieter the echo will be. Values less than 50 give

good results.
To  make  the  echo  sound  correct,  GoldWave  extends  the  effect  slightly

outside the block boundary.  This may increase the length of the sound.  If you do
not want to modify sound outside the block or you do not want the length of the
sound to change, use the Options | Editing dialog to disable modification outside
the block.
To add an echo:

1) Move the start and finish markers to the part of the sound you
want to add an echo.
2) Choose Echo from the Effects menu.
3) Enter the delay time, then choose OK.
4) Enter the volume, then choose OK.

3.7.2 Fade out
Gradually decreases the volume throughout the block.  The percentage of

fade can be entered after  choosing this  command.   The fade percentage is  the
amount that the volume should decrease.  A value of 100 fades to complete silence.
A value of 50 fades to half the original volume.
To fade out part of a sound:

1) Move the start and finish markers to the part of the sound you
want to fade.
2) Choose Fade out from the Effects menu.
3) Enter the fade percentage, then choose OK.

Tip: To fade in a sound, Reverse the block first, Fade out, and Reverse it again.

3.7.3 Invert
Reflects  the sound about the x (time) axis.   This produces no noticeable

effect in mono sounds and has a slight effect in stereo sounds.  Anyone have a use
for this effect?

3.7.4 Maximize volume
Searches  the  block  for  the  maximum  percent  that  the  volume  can  be

increased without  producing distortion or  clipping errors.   This  volume is  then
applied to the sound.  If  the percentage is above 2000% or equal to 100%, no
changes will be made.  See Volume for more information.

3.7.5 Playback rate



Changes the playback rate of the entire sound.  The sound will play faster (or
slower) and its pitch will be higher (or lower).  Essentially, this just changes the
first number in the information bar.  Values of 11025, 22050, and 44100 are the
recommended values.

Tip:  If you want to convert the actual sampled data from one sampling rate to
another, you could use Edit | Copy and Edit | Paste.  If the file you copy from is
sampled at 22050Hz and the file you paste to is sampled at 11025, then the paste
command will down-sample the data as it is being pasted.  This cuts the size of the
sound file in half.  Up-sampling is also possible this way.

3.7.6 Reverse
Reverses the block so that it plays backward.  Now you have an easy way to

listen to all those "satanic verses".

3.7.7 Silence
Erases the block.  The sound in the block is muted (set to zero volume).

3.7.8 Volume
Modifies the block so that it  sounds louder or softer.   The percentage of

volume can be entered after selecting this command.  Values less than 100 make
the sound softer and values greater than 100 make the sound louder.  A value of
100 has no effect.  Enter 50 to half the volume and 200 to double the volume.

By  using  independent  left/right  editing  (Options  |  Editing),  the  internal
balance of a sound can be adjusted.

The Scope and Controls window can also affect volume.  It only changes the
device's output volume, whereas the Volume effect actually changes the volume
within a sound.

3.7.9 Expression evaluator
Allows you the create new effects or generate signals.  See appendix B for

more details.

3.8 Options Menu Commands

3.8.1 Input device
Presents  a  list  of  input  devices  that  were  installed  with  Control  Panel's

Drivers applet.  If no input devices are installed, a warning message is displayed
and recording is disabled.



The list shows you the name of the device/driver.  Above the list is a table
that tells you what sound attributes/formats the driver supports.  All boxes with
check marks in them are supported by the currently selected driver.  You can select
any driver to see its capabilities.

Tip: Since you can choose the input device, you can have several devices/drivers
installed at once.  Note: The drivers must not interfere with each other.

3.8.2 Output device
Presents  a  list  of  output  devices  that  were installed  with Control  Panel's

Drivers applet.  If no output devices are installed, a warning message is displayed
and playback is disabled.

The list shows you the name of the device/driver.  Above the list is a table
that tells you what sound attributes/formats the driver supports.  All boxes with
check marks in them are supported by the currently selected driver.  You can select
any driver to see its capabilities.

Tip: Since you can choose the output device, you can have several devices/drivers
installed at once.  For example, it is possible to have the PC-Speaker driver and a
Sound  Blaster  driver  installed  at  the  same  time.   Note:  The  drivers  must  not
interfere with each other.

3.8.3 Aux volume
Sets the output volume on an auxiliary device.  This may be useful when

recording from a CD-ROM.  A list of installed auxiliary devices is displayed or a
warning message is given if no auxiliary devices are present.
To change auxiliary output volume:

1) Select  a  device.   If  the  device  supports  volume control,  the
"left" control will be enabled.  If the device supports stereo volume
control, both the "left" and "right" controls will be enabled.

2) Adjust the volume with the "left" and/or "right" controls.

Note:  This feature is untested (I don't have the hardware to test it).

3.8.4 Settings
Changes several features in GoldWave.
Sound Path is used by  File | Open.  You can specify the directory where

you keep your sound files.  If you type "d:\sound\wave", for example, the  File |
Open dialog will automatically list the files in that directory whenever you start
GoldWave.



If  Save window positions is  checked,  the  main  window and Scope and
Controls window positions will be saved when you exit GoldWave.  This means
you will not have to adjust window positions every time you start GoldWave.

If  Load uLaw as 8-bits is checked, any encoded file (".au" files) will be
converted to 8-bit  PCM format.  This will  cause some loss of quality, but will
allow playback on a larger variety of audio devices.  If the box is not checked, the
data is converted to 16-bit PCM format. If your audio device supports 16-bit PCM
files, uncheck this box.

The  Scope  active check  box  enables  or  disables  the  oscilloscope.
Unchecked,  the  oscilloscope  is  disabled  during  playback  and  recording  (the
oscilloscope box will still be present).

The Quick block select check box allows you to choose which method to
use when selecting a block.  See Editing Overview for more information.

3.8.5 Editing
Sets the behaviour of editing and effects.  These options apply only to the

currently  active  sound.   This  means  you  can  have  different  "behaviours"  for
different sound windows.

Channel Editing lets you control which channel (or channels) will be edited
for  stereo sounds.   For  example,  if  you choose  "Left  channel",  all  effects  and
editing will only change or use the left channel.   You can then use Edit | Copy to
extract the left channel into the clipboard or use Edit | Mix to mix the clipboard
with the left channel and so on.

The Modify outside block check box allows you to protect sounds outside
the block from being changed (Effects | Echo uses this).

3.8.6 Register
Allows you to register your copy of GoldWave in your own name.  To get a

password, please see Registering in Section 4.

3.9 Window Menu Commands

The Window Menu contains a list of all sound windows currently opened.
These commands organize sound windows.

3.9.1 Tile
Arranges sound windows side-by-side so that they are all fully visible.

3.9.2 Cascade
Layers sound windows on top of each other so that their title bars are visible.



3.9.3 Arrange icons
Arranges minimized sound window icons in rows.

3.10 Help Menu Commands

3.10.1 Contents
Starts  Window's  on-line  help  utility  and  gives  a  list  of  contents  for

GoldWave help.

3.10.2 About
Displays  version/registration  information.   Shows  how  much  memory  is

available under the GoldWave icon.

4 General Information

4.1 ShareWare Concept and Warranty

GoldWave  is  designated  as  ShareWare.   This  means  that  you  may  use
GoldWave free for a 30 day trial period.  At the end of this period, if you decide to
keep GoldWave, you are required to register (see Registering below).  GoldWave
has  not  been  crippled  in  any  way.   Therefore,  your  honesty  and  support  are
essential for future development of this application.  You are encouraged to give
copies  to  all  your  friends  and  upload  it  to  BBS  and  ftp  sites  (see  below for
restrictions).

GoldWave brings affordable multimedia to the multitudes.

GOLDWAVE.ZIP  ("the  package")  includes  the  following  software  and
documentation:

GOLDWAVE.EXE
GOLDWAVE.HLP
GOLDWAVE.WRI
README.TXT
REGISTER.TXT
BWCC.DLL

The package is copyright 1993 by Chris S. Craig.



You may copy and distribute the package through BBS and ftp sites.  Only
the GOLDWAVE.ZIP file may be distributed or copied.
You are prohibited from:

charging a fee or requesting donations for the package;
distributing or including the package in commercial products;
modifying the package .

The package is provided as is, without warranty of any kind.  The author shall not
be liable for damages of any kind.  Use of this ShareWare software indicates you
agree to this.

All trademarks/registered name acknowledged.

4.2 Contacting the Author

I  would  appreciate  any  registrations,  comments,  suggestions,  and  bug
reports.   During May '93 to August  '93 and January '94 to April  '94,  I  will  be
completing the last two academic Terms (7 and 8) of my university degree.  I will
do  my  best  to  provide  user  support,  but  I  may  not  have  time  to  answer  all
questions.

Important:
Please do not ask programming or development questions such as "Can I

have the source code?", "What does your sound class structure look like?", "How
can I  make an  oscilloscope?",  etc.   These type of  questions can take hours  to
respond  to.   Therefore,  I  will  only  answer  questions  relating  to  the  use  of
GoldWave.

You can send e-mail to:

chris3@garfield.cs.mun.ca

I prefer e-mail.  Be sure to give a valid return address.

Regular mail/registrations can be sent to:

Chris Craig
P.O. Box 51
St. John's, NF



CANADA  A1C 5H5

Thank-you for using GoldWave.

4.3 Registering

If you think GoldWave is a useful utility,  a registration of $30 Canadian
(only $25 US) would be appreciated.  You will receive a password that will register
your copy of GoldWave in your name and remove any registration messages.

If you send more than $59 Canadian, you will receive the next version of
GoldWave when it is available.

To register,  fill  in the REGISTER.TXT file,  then print  it  out  and mail  it
along with your check or money order to the address in the previous section.

4.4 Reporting Problems and Bugs

This is my first Windows program as well as my first major C++ project.
This is also the first release (GoldWave v1.00), so there may be some problems.
See Contacting the Author for more information.

Known problems:
   - Some audio drivers report the current play/record position incorrectly.  This

means that the oscilloscope will be inaccurate.
   - If you try to delete a single sample, 2 samples will actually be deleted.
   - No cross-fading is performed on editing boundaries.
   - No anti-aliasing filter is applied when paste or mix down-samples.
   - Oscilloscope graph is inverted (its quicker that way).

4.5 Trouble Shooting

Problem:
Cannot  play  sounds  GoldWave  or  audio  device/driver  is  incorrectly
installed.

Solution:
Make  sure  a  WAVE driver  is  installed  in  the  Control  Panel's  Drivers
applet.
Check that Window's Sound Recorder can play sounds.  If it doesn't, the



driver  is  not  installed  correctly.  Make  sure  that  your  audio  device  is
capable of playing the sound.  For example, an 8-bit audio device cannot
play a 16-bit sound.

Problem:
Cannot record sounds

Solution:
See above.
Make sure your audio device/driver can record sounds.
The sound may be paused.  Click on the stop button.

Problem:
Cannot use the stop or pause button
Oscilloscope does not work

Solution:
The audio driver is synchronous.  This means that Windows (and GoldWave)
loses control until the sound has finished playing.
Oscilloscope is not active (Options | Settings).

Problem:
Oscilloscope is out of sync

Solution:
Many audio drivers return inaccurate 'current' positions.  Make sure you 
have the most up-to-date device driver.

Problem:
Periodic popping or clicking while playing a pure sine wave

Solution:
Most audio devices/drivers make periodic pop/clicks between DMA 
transfers and/or memory boundaries.  It is most noticeable when playing 
pure sine waves.
Pops and clicks can occur at the beginning or ending of a sound if the first or
last sample is not 0 (silence).  Fading in/out a small block can sometimes fix 
this.

4.6 Revision History

v1.00:
First release.  Includes: mono/stereo, 8/16 bit, uLAW, independent channel



editing, up to 5 sound windows, detached Scope and Controls window, tool
bar,  information  (attributes)  bar,  MDI,  expression  evaluator,  and  several
effects.

4.7 Future Versions and ScopeTrax

Here's a list of possible future enhancements to GoldWave:
   - Full keyboard support for moving start/finish markers
   - Sampling rate conversion command, instead of having to use paste
   - More DSP/FFT effects (Pitch shift, time compress/expand, filters, etc.)
   - Add Print command for sound graphs
   - OLE support
   - Direct editing with the mouse
   - Support for ADPCM, unsigned 16-bit, etc. file formats
   - More device control (loop, play block, window, all)
   - "Save as" saves files with any format
   - Better on-line help
   - etc...

ScopeTrax Note:
ScopeTrax (released March '92) is a sound player for DOS that has a true

real-time oscilloscope and the ability to play clearly through most PC-Speakers.  I
had planned to make new versions of ScopeTrax, but because of several limitations
with DOS (640K barrier, lack of standard sound drivers, etc.), GoldWave may have
to replace ScopeTrax.  If a larger number of people disagree, I will try to make a
new version of ScopeTrax.  I still have not received enough donations to afford a
new Sound Blaster Pro or SB16 ASP developer kit.
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Appendix A: Audio Attributes/Terminology

A.1 Digital Sound Attributes

A digital sound (sampled sound) is composed of thousands of pieces of data,
called samples.  Each sample holds the loudness (amplitude) of a sound at a given
instant  in time.  This  is  similar  to computer  graphics where each point  of  light
(pixel) has a certain brightness and location.  All these points combine to make a
picture.  In digital sound, all the samples combine to make a sound.  There are
several attributes that determine the quality and quantity of digital sound.  They
are: sampling rate, number of bits, and number of channels.

The  Sampling rate is  the number of times,  per second, that  a sample is
recorded.  It is measured in Hertz (seconds-1, Hz).   A high sampling rate will yield
a high quality of digital sound in the same manner that high graphics resolution
will show better picture quality.  Compact disks, for example, use a sampling rate
of 44100Hz, whereas some telephone systems use a rate of only 8000Hz.

The rate to use depends upon the type of sound and the amount of memory
and disk  space  you have  available.   Higher  rates  consume larger  quantities  of
memory.  In the above example, the compact disk may require over 5 times the
amount of storage as the telephone system for the same digital sound.

Certain  types  of  sounds  can  be  recorded  at  lower  rates  without  loss  of
quality.  Some standard rates are listed in a table at the end of this section.

The number of bits determines how accurately the amplitude of a sample is
recorded.  The two most common are 8-bit and 16-bit formats.  In an 8-bit sample,
there are 256 different levels of amplitude possible.  16-bit samples have 65536
levels.  To compare the difference, let's say that you are a teacher grading tests and
you can use one of two marking schemes.  In scheme #1, the mark is out of 10.  In
scheme #2, the mark is out of 1000.  All marks must be rounded off (no fractions



allowed).  If a student gets two thirds of the questions right, then in scheme #1, the
grade will  be 7 out  of  10.   In scheme #2,  the grade will  be 667 out of  1000.
Obviously, scheme #2 is more accurate.  In digital sound, low levels of accuracy
can cause quantization errors, as discussed in the next section.

One drawback of using 16 bits is that it uses twice as much storage space.
This is shown in a table at the end of this section.

The  number  of  channels also  affects  the  quality  and  quantity  of  digital
sound.  A single channel sound, referred to as a mono sound, contains information
for  only one speaker  (i.e.  similar  to  AM radio).   A two channel  sound (stereo
sound) contains data for two speakers (i.e.  similar to FM stereo).  Stereo sounds
require twice as much storage as mono sounds.

Format/Attributes
Quality/Sound type

Quantity, Storage/second

11025Hz, 8-bit, mono
Fair quality.  Good for speech and low pitch sounds.

11025 bytes

11025Hz, 8-bit, stereo
Fair quality stereo.

22050 bytes

11025Hz, 16-bit, mono
Less noise.

22050 bytes

11025Hz, 16-bit, stereo
Stereo, less noise.

44100 bytes

22050Hz, 8-bit, mono
Good quality.  Good for music and relatively complex sounds.

22050 bytes

22050Hz, 8-bit, stereo
Good quality stereo.

44100 bytes



22050Hz, 16-bit, mono
Very good quality.

44100 bytes

22050Hz, 8-bit, stereo
Very good quality stereo.

88200 bytes

44100Hz, 8-bit, mono
High quality.  Good for all sounds.

44100 bytes

44100Hz, 8-bit, stereo
High quality stereo.

88200 bytes

44100Hz, 16-bit, mono
Excellent quality.

88200 bytes

44100Hz, 16-bit, stereo
Excellent quality stereo.  Large storage requirements.

176400 bytes

Amplitude vs. Volume Note
Amplitude is the height of a wave.  Volume is amplitude measured in dB,

which is a logarithmic scale.

A.2 Problems with Recording

There are five potential problems when recording sound:  aliasing, clipping,
quantization, internal noise, and DMA/memory boundaries.

Aliasing occurs when the  sampling process  does  not  get  enough data  to
correctly determine the shape of the sound wave.  The digital sound will have high
or low pitch tones that never existed in the original sound (See Appendix B, end of
Signal  Generation  section  ).   This  problem can  be  eliminated  by using higher
sampling rates (or by using anti-aliasing filters).



Clipping errors occur when the sampled amplitude is outside the range of
valid values.  For example, if the range is -1.0 to 1.0, and a value of 1.2 is sampled,
then this value must be clipped to 1.0.   A way to reduce these errors is to lower the
input volume when recording.

Quantization errors occur when the sample is rounded to the nearest level
of amplitude.  This can be explained by using the "marking schemes" example of
the previous section.  The number two thirds (2/3) is represented by 7/10 in scheme
#1.  This gives a quantization error of:

| 7/10 - 2/3 | = 1/30

Similarly, in scheme #2, the quantization error is:

| 667/1000 - 2/3 | = 1/3000

Clearly, scheme #1 has the smallest error.  Therefore, using 16 bits instead of 8 bits
is a good way to reduce quantization errors.

The  other  two  recording  problems  deal  with  computer  hardware.   To
minimize internal noise, make sure your audio card is installed as far away from
your graphics/monitor adaptor card as possible.  If you use a microphone, keep it
away from your monitor and computer fan.  Remember to use shielded cables.

DMA and memory boundaries can cause loss of quality during recording and
playback (pure sine waves rarely play without some "defects").  When recording at
high sampling rates (in DOS), use a RAM disk.  Unfortunately, Windows offers
little control over when disk accesses will occur.  Some of the latest audio cards
and drivers may reduce this problem.

Appendix B: Expression Evaluator

B.1 Overview

The Expression Evaluator is a versatile tool for manipulating and generating
audio data.  After you select Expression evaluator from the Effects menu, you are
presented with a dialog (a window) that is similar in appearance to a calculator.

On the left side, below the number buttons, is the  Destination box.  The
destination is defined as the sound window where results of the evaluation will be
placed.  The box's drop-down list contains a list of all sound windows in the form
"wavex", where x is the number on a sound window as given in its title bar.  For



example,  a  sound  window with  the  title  "3  -  HELLO.SND"  would  appear  as
"wave3" in the list.  By default, the destination is set to the active sound window
(the one on top).  You can change the destination, if more than one sound window
is opened, by using the up and down cursor keys or by selecting it with the mouse
from the drop-down list.

A large Expression box is located in the middle of the dialog.  This is where
the expression is entered.  To enter an expression, you can either type it in or click
on "calculator" buttons with the mouse.  A list of valid operations and functions is
given in a following section.

At the bottom left side of the dialog are two boxes where the initial values of
the variables 'n' and 't' may be entered.

After  you  have  specified  the  destination,  expression,  and  initial  values,
choose the OK button (or just press the "enter" key) to begin evaluation.  If you
entered an expression incorrectly, a message will be displayed in the Message box.
The Message box also gives the progress during evaluation.  Since the evaluation
process takes time, you can stop it at any time with the Cancel button.  Pressing the
Cancel button a second time will close the Expression Evaluator dialog.

B.2 Evaluation Range, Variables, and Constants

Expressions are evaluated over the destination sound window's block.  You
must set start and finish markers before you open the evaluator dialog (Refer to
Editing Overview for  more information).   Let's  assume we have the following
before opening the dialog:

Title bar: "1 - Untitled"
Sampling rate: 8000Hz
Start marker at 0.5 seconds
Finish marker at 1.2 seconds

After we open the dialog, we set:
Destination: "wave1"
Expression: "sin(t)"

The initial  value for t  is automatically set to 0.5.  If you now choose OK, the
expression "sin(t)" will be evaluated from t = 0.5 to t = 1.2 in steps of 1/8000
seconds.  You will get:

wave1(0) = sin(0.500000)



wave1(1) = sin(0.500125)
wave1(2) = sin(0.500250)

...
wave1(3) = sin(1.200000)

Time Variable and Constant
The variable "t" is the time variable and, as demonstrated above, it changes

throughout the start/finish range.  The step of change is determined by the inverse
of the destination's sampling rate.  This inverse is assigned to a special constant,
"T".  In the above example, T = 0.000125 (i.e. 1/8000).  Constant "T" and variable
"t" are automatically reset when a new destination is selected.

Sample Index Variable and Total Constant
The variable "n" is the sample index variable.  It is always an integer value.

During evaluation, this variable is continuously incremented in steps of 1.  The
sample index variable is used whenever an operation must be performed on an
existing sample.  A value of n = 0 (the initial default value) is the index of the
sample  at  the  start  marker's  position  of  the  given  signal.   For  example,  the
expression

wave2(n) + wave3(n+100)

takes the wave2 sample at wave2's start marker's position and adds it to the wave3
sample 100 samples after wave3's start marker's position.  If a sample index is
outside the wave's block, the value is 0 (i.e. wave2(n-50) = 0 while n < 50).

You must be careful when indexing signals with different sampling rates to
get a desired effect.  Assume wave1 is a voice recorded at 11025Hz and wave2 is
music recorded at 22050Hz.  If you want to sum (superimpose) the two signals
with wave1 as the destination, then the expression

wave1(n) + wave2(n*2)

must be used (ideally, wave2 would have to be low-pass filtered first).  Whereas, if
wave2 is the destination, the expression should be

wave1(n/2) + wave2(n)

A constant "N" is set to the total number of samples in the evaluation range.
It has several uses, such as reversing a sample.  Assume wave2 is a new sound that
has the same sampling rate and length of wave1.  By setting the destination to



wave2 and using

wave1(N-n-1)

wave2 will be the reverse of wave1.

Conversion Between Variables
n = (t - initial value)/T
t = n*T + initial value

B.3 Valid Operations and Functions

The  following  table  summarizes  the  operations  and  functions  included  in  the
evaluator.   Note  that  although the  "%" operator  is  not  shown in  the  evaluator
dialog, it is a valid operator.

Label Operation, function

(, ) Parenthesis
+, *, -, / Add, multiply, subtract (negate), and divide
% Modula operator (remainder)
^ To the power of, yx

pi Constant (3.14159...)
cos Cosine
sin Sine
tan Tangent
acos Arccosine
asin Arcsine
atan Arctangent
cosh Hyperbolic cosine
sinh Hyperbolic sine
tanh Hyperbolic tangent
sqrt Square root
abs Absolute value
log, ln Log base 10, natural logarithm
exp Exponential base e
step Unit step ( 0 for t < 0, 1 for t >= 0 )
int Integer value



rand(n) Random number between 0 and n
wavex(n) Signal value at n

B.4 Signal Generation

Generation expressions of several signals are listed below. Words given is italics
are values that you must enter.

Type: Sine wave
General Expression:

sin(2*pi*frequency*t)

Examples:
Middle C:

sin(2*pi*261.7*t)
1000Hz and 750Hz tones:

( sin(2*pi*1000*t) + sin(2*pi*750) ) / 2

Type: Square wave
General Expression:

sin(pi*int(2*frequency*t))

Examples:
1000Hz tone:

sin(pi*int(2*1000*t))
Middle C:

sin(pi*int(2*261.7*t))

Type: Saw (triangle) wave
General Expression:

1 - 2*abs(1 - 2*frequency*t%2)

Example:
200Hz tone:



1 - 2*abs(1 - 2*200*t%2)

Other examples of signals:

Noise:
1 - rand(2)

Exponential decay of 500Hz cosine wave to 50%:
cos(2*pi*500*t) * (0.5*exp(-t) + 0.5)

Slow sweep (up to 20kHz):
sin( 2*pi*160*(t%5)^3 )

The Sweep is a great way to see and hear aliasing if the destination signal has a
low sampling rate.  The ideal output should be a single tone increasing in pitch
until it is nearly outside the range of human hearing.  In reality, you will be able to
hear two or even three tones, some rising in pitch and some falling!

B.5 Filters

One of the easiest ways to create digital filters is to use MATLAB™ (The
Student Edition of MATLAB, by The Math Works Inc., published by Prentice-Hall,
ISBN  0-13-855974-0).   It  has  many  built-in  commands  that  generate  filter
coefficients.  The coefficients can then used in the expression evaluator.

Example of a Low-Pass Filter

In preparation for down-sampling, you can use MATLAB to generate the
coefficients of a 4th order Butterworth low pass filter that will remove noise above
half the Nyquist frequency (1/4 the sampling rate).  Enter:

[b,a] = butter(4, 0.5)

The result should be:
b = 0.0940 0.3759 0.5639 0.3759 0.0940
a = 1.0000 0.0000 0.4680 0.0000 0.0177

To implement this filter in GoldWave, let's assume that the sound to be filtered is in
the sound window titled "1 - SOUND.SND".



1) Use  File | New to create a new sound window with the same
sampling rate as "1 - SOUND.SND".  The new sound window will be
titled "2 - Untitled".
2) Make sure the length of the new sound is as long (or longer)
than the original.  If it is not, use Edit | Insert space to increase its
length.
3) Use  Effects  |  Expression  evaluator to  open  the  expression
evaluator dialog.

4) Set the destination to wave2.
5) Enter the following expression:

wave1(n)*0.0940 + wave1(n-1)*0.3759 + wave(n-2)*0.5639 + 
wave1(n-3)*0.3759 + wave1(n-4)*0.0940 - wave2(n-2)*0.4860 - 
wave2(n-4)*0.0177

6) Choose OK (You might want to get a coffee while you wait).


